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ISE 14.7 Installer - X
\ Welcome
’ We are glad you've chosen Xilinx as your platform development partner. This program will install ISE
‘ design environment, Software development kit or Lab tools.

You will need to have administrator privileges in order to install this software on Windows operating
systems.

For the product you select to install, we recommend that you identify a directory that does not
contain an older installation of the same product version.

Note - To reduce installation time, we recommend that you disable any anti-virus software before
continuing
ISE 14.7 Installer

-> Welcome
Accept License Agreements
Select Products to Install
Select Installation Options
Select Destination Directory

Installation

Copyright (¢) 1995-2013 Xilinx, Inc. All rights

reserved,
XILINX, the Xilinx logo and other designated
brands inchuded herein are wademarks of Xilinx,
Inc. Al other wademarks are the propety of
therr respective owners.
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ISE 14.7 Installer

CISE

&«

ISE 14.7 Installer

Welcome

-> Accept License Agreements
Select Products to Install
Select Installation Options
Select inati i ¥

Accept License Agreements (1 of 2)

Please read the following terms and conditions and dlick the checkbox below it to indicate that you
accept and agree.

ILINX, INC. E‘
END USER LICENSE AGREEMENT

CAREFULLY READ THIS END USER LICENSE AGREEMENT (AGREEMENT"). BY CLICKING THE
"ACCEPT" OR "AGREE" BUTTON, OR OTHERWISE ACCESSING, DOWNLOADING, INSTALLING OR
USING THE SOFTWARE, YOU AGREE ON BEHALF OF LICENSEE TO BE BOUND BY THIS

AGREEMENT.

IF LICENSEE DOES NOTAGREE TO ALL OF THE TERMS AND CONDITIONS OF THIS AGREEMENT,
DO NOT CLICK THE "ACCEPT" OR "AGREE" BUTTON ORACCESS, DOWNLOAD, INSTALL OR USE
THE SOFTWARE; AND IF LICENSEE HAS ALREADY OBTAINED THE SOFTWARE FROM AN
AUTHORIZED SOURCE, PROMPTLY RETURN IT FOR A REFUND.

1. Definitions

Installation

ther respective owness,

Copyright (c) 1995-2013 Xilinx, Inc. All rights

reserved.

XILINX, the Xilinx logo and other designated
brands inchuded herein are wademarks of Xilinx,
Inc. Al other wademarks are the property of

on Codes™ means any FLEXIm license key, license file, license manager, dongle or other

key, code or information issued by (or on behalf of) Xilinx that is necessary to download, install, operate

and/or regulate User access to the applicable Software. _|
-

2
2

I also confirm that [ have read Section 13 of the terms and conditions above concerning WebTak and have been afforded
the opportunity to read the WebTalk FAQ posted at http: /fwww.xilinx.comfise jwebtalk/. I understand that I am able to
disable WebTalk later if certain criteria described in Section 13(c) apply. If they don't apply, I can disable WebTalk by
uninstaling the Software or using the Software on a machine not connected to the internet. If I fail to satisfy the
applicable criteria or if I fail to take the applicable steps to prevent such transmission of information, I agree to allow Xilinx
to collect the information described in Section 13(a) for the purposes described in Section 13(b).

ccept and agree to the terms and conditions above

also accept and agree to the following terms and conditions

Ce ) o

——
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ISE 14.7 Installer

CISE

&«

ISE 14.7 Installer

Welcome

-> Accept License Agreements
Select Products to Install
Select Installation Options
Select Destination Directory

Installation

reserved.

ther respective owners,

Copyright (c) 1995-2013 Xiin, Inc. Al rights

XILINX, the Xilinx logo and other designated
brands inchuded herein are wademarks of Xilin,
Inc. Al other wademarks are the property

Accept License Agreements (2 of 2)

Please read the following terms and conditions and click the checkbox below it to indicate that you
accept and agree.

CAREFULLY READ THIS COLLECTION OF INFORMATION AND LICENSE AGREEMENTS. BY
CLICKING THE "ACCEPT" OR "AGREE" BUTTON, OR OTHERWISE ACCESSING, DOWNLOADING,
INSTALLING OR USING THE SOFTWARE, YOU AGREE ON BEHALF OF LICENSEE TO BE BOUND BY
THIS INFORMATION AND LICENSE AGREEMENTS (TQ THE EXTENT APPLICABLE TO THE SPECIFIC
SOFTWARE YOU OBTAIN AND THE SPECIFIC MANNER IN WHICH YOU USE SUCH SOFTWARE).

B

IF LICENSEE DOES NOTAGREE TOALL OF THE INFORMATION AND LICENSE AGREEMENTS
BELOW, DO NOT CLICK THE "ACCEPT" OR "AGREE" BUTTON OR ACCESS, DOWNLOAD, INSTALL
OR USE THE SOFTWARE; AND IF LICENSEE HAS ALREADY OBTAINED THE SOFTWARE FROM AN
AUTHORIZED SOURCE, PROMPTLY RETURN IT FORAREFUND.

Part One: Overview.

The following information applies to certain items of third-party technology that are included along with
certain Xilinx software tools.

The Xilinx Embedded Development Kit (EDK) is a suite of software and other technology that enables
Licensee to design a complete embedded processor system for use in a Xilink Device. EDK includes,
amaong other components, (3) the Xilinx Platform Studio (XPS), which is the development environment,
or GUI, used for designing the hardware portion of an embedded processor system; and (b) the Xilinx
Software Development Kit (SDK), which is an integrated pment i L tary to
XPS, thatis used to create and verify C/C++ embedded software applications. SDK is also made
available separately from EDK.

Licensee's use ofthe GNU compilers (including associated libraries and utilities) that are supplied
with SDK may cause Licensee's software application (or board-support package) to be governed by

=

¥ ) accept and agree to the terms and conditions above
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ISE 14.7 Installer - X

A Select Products to Install

’ =l Edition List
\ = ISE WebPACK.
" ISE Design Suite Logic Edition

" ISE Design Suite Embedded Edition
" ISE Design Suite DSP Edition

" ISE Design Suite System Edition

P

Lab Tools - Standalone Installation

ISE 14.7 Installer

Welcome Disk Space Required : 17480 MB
Accept License Agreements
-> Select Products to Install
Select Installation Options Description of ISE WebPACK
Select Destination Directory
Installation ISE WebPACK contains the most important tools you need for designing CPLDs and small to

medium-sized FPGAs. Includes: ISE Design Tools (w/reduced device support), PlanAhead,
Connectivity DSP IF. ChipScope Pro and The Embedded Development Kit will also be installed
with WebPACK but are licensed separately (not included in a WebPACK license file).

Copyright (c) 1995-2013 Xilinx, Inc. All rights
reserved,

XILINX, the Xilinx logo and other designated
brands included herein are wademarks of Xilin,
Inc, Al other vademarks are the property of

their respective owners,
—
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ISE 14.7 Installer

“ Select Installation Options

' Select the desired installation options below. Selection of these options may result in additional
rograms being run at the conclusion of the installation process.

\ se multiple CPU cores for faster installation

Enabling this option will speed up installation but may siow down other active applications.

Acquire or Manage a License Key
Install WinPCap for Ethernet Hardware Co-simulation
[ Install Cable Drivers

ISE 14.7 Installer

Welcome

»

Accept License Agreements 4| |
Select Products to Install

-> Select Installation Options Select/Deselect All

Sel, Desti Di
ect Destination Directory Description of Acquire or Manage a License Key

Installation

Most Xilinx applications now require a license key file in order to run. If this selection is enabled,
the Xilinx License Configuration Manager will be opened in order to assist you either in acquiring
a new license file or in managing an existing license file. If this is your first time using Xilinx ISE
Design Suite 14.7, it is highly recommended that you use this application to acquire or install
your license file.

Copyright (c) 1995-2013 Xiinx, Inc. All rights
reserved,

XILINX the Xiinx logo and other designated
brands included herein are trademarks of Xilinx,
Inc. All other trademarks are the property of
their respective owners.
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ISE 14.7 Installer

CISE

€ Select Destination Directory

Select the directory where you want the software installed.
J c:xilinx

Install location(s) :
C:\Xilinx\14.7\ISE_DS

Disk Space Required :

| srowse...

17480 MB

Disk Space Available : 163993 MB

ISE 14.7 Installer

Welcome

Accept License Agreements

Select Products to Install

Select Installation Options
-> Select Destination Directory

¥ Create Start Menu and Desktop Icons

Select a Program Folder
Installation
This name will appear in the Start Menu > Programs list.

|X|‘I‘|nx Design Tools

¥ Tool preferences and file association

Import tool preferences from previous version and change project file association to ISE WebPACK 14.7

Copyright (c) 1995-2013 Xilinx, Inc, All rights
reserved,

XILINX, the Xilinx logo and other designated
brands inchuded herein are trademarks of Xilin,
Inc. All other trademarks are the property of
their respective owners.
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ISE 14.7 Installer

CISE

< Installation

Options Summary

Install Location(s):
C:\Xilinx\14.\ISE_DS

Edition : ISE WebPACK

Program Group: Xilinx Design Tools
Option: Acquire or Manage a License Key

ISE DS Common

Install Location: C:\Xilinx\14.7\ISE_DS\common

Module: ISE DS Common

Option: Script to install VC++ runtime libraries for 32bit 0S
ISE 14.7 Installer Option: Script to install VC++ runtime libraries for 64-bit 0S
EDK

Install Location: C:\Xilinx\14.7\ISE_DS\EDK

Module: EDK

Option: MB Linux Toolchain post-install

Welcome

Accept License Agreements

Select Products to Install

Select Installation Options

Select Destination Directory
-> Installation

PlanAhead Analysis Tool

Install Location: C:\Xilinx\14.7\ISE_DS\PlanAhead
Module: PlanAhead Files

Option: setupEnv bat

ISE

Install Location: C:\Xilinx\14.7\ISE_DS\ISE
Module: Design Environment Tools

Module: WebPACK Devices

Copyright () 1995-2013 Xiinx, Inc. All rights
reserved,

XILINX, the Xilinx Jogo and other designated
brands included herein are trademarks of Xilin,
Inc. All other trademarks are the property of
their respective owners.

Option: Install WinPCap for Ethemet Hardware Co-simulation

Option: Install Windows System Generator Info XML

Option: Install Cable Drivers

Option: Enable WebTalk to send software, IP and device usage statistics to Xilinx (Always enabled for WebPACK license)

p—
< Back [ Instal ) Cancel
—
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ISE 14.7 Installer [ 86% ] = X

< ISE DS Common:
' Script to install VC++ runtime libraries for 32-bit OS
iy IR nnnnnnnnnnnm 86%

3ISE

ISE 14.7 Installer
Welcome Accelerate Productivity with Xilinx Targeted Design Platforms
Accept License Agreements
Select Products to Install
Subicx Tnstallatios Optioas » Xilinx development kits provide out-of-the box solutions that significantly

Select Destination Directory

) cut development time and enhance productivity. Xilinx takes it one step
-> Installation

further with targeted design platforms - the industry's most comprehensive
development kits.

Copyright (¢) 1995-2013 Xiinx, Tnc. All rights www.xilinx.com/kits X| LI NX
reserved.

PROGRAMMABLE.

XILINX, the Xiinx logo and other designated
brands inchuded herein are rademarks of Xilinx,
Inc. All other trademarks are the property of
their respective owners,

Cancel
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£ Xilinx License Configuration Manager - O x

Acquire a License Borrow/Restore Licenses Return Licenses I Internet Settings

Instructions: Click the “Load License™ button to sither load 3 response XML fil into XLCM to activate your machine for Xilinx tocis and IR or copy &
certficate-based icense (.lic file) into the local JGiinx directory. Xiinx applications automatically detect valid, node-locked licenses (*.lic) residing in the
Y local Jinx directory.

=

Te point to a floating server license, or to point to license files in locstions cther than Xiiinx, set one of the environment variables belowr. (Linux users
wiill need to make these settings outside of this application.)) Bxamples: 1234@server; Cs\icenses\Xilinx.lic (Windows) or 1234@server:/usr/local/fledm
(Uinw)

XILINXD_LICENSE_FILE |

=1
LM_UICENSE_FILE |
HIDDEN [V Hide Built-in Fres Licenses Clear Cache
Information ﬂ

Feature S/Wor

IP Core

Version
Limit

License
Type

Expiration
Date

Count Licenses

In Use

‘ o

Local System Information

Hostname: ALI-DESKTOP
Netwiork Interface Card (NIC) ID:

C: Drive Serial Number:

FLEXID Dongle ID:

e o
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4 ISE Project Navigator (P.20131013) - C\Xilinx\Project1\Project1\Project1.xise - [Design Summary] - a x
L File Edit View Project Source Process Tools Window Layout Help O LJL]
DaHg & Xlowa| = frEar@A R0, P9
pesion w0 & x| . [© Design Overview ~ FreTT———
Ve © 15 lemsrtaton O [l semision | W Sommary Preguct orfactiaen [ o Erers
Hodule Hame: Moduet Tmplementation State: Hew
Target Device: [—e— _
Product Version: 155 147 [ Warnings:
Design Gosk: aanced * Routing Resuhts:
= Emr s Defpul (uniocked) Timing Canstraints:
Final Timing Score:

Y Place and Route M oef s =]
b g e ) Tiing Mot sm == 1L T{®1] e =
@ I . Syrthess Report
= Detailed Reports Transistion Report
h| t Report Map Repot
B £ Mo Processes Running T ——
{; | Processes: Module1 - Behavioral Povwer Report
| £ OesignSummary/Reports Post PAR Statc Timing Rapart
Design Utifties I |
Stgen Report
L@ User Constraints Design Properties
— | @ 82 Synthesize- XST [ Enable Message Filtering
5 €2 Implement Design Optional Design Summary Contents
2 Generate Programming File [ Show Clock Report [ Sessniory Repevts o}
@ @  Configure Target Device [ Show Failing Constraints | Report Hame Status Generated
Analy Design Using ChipS: Show Wamings
@  Analyze Design Using ChipScope Eshw i g Date Ganaratad: 10/25/2013 - 20:07:%

byl 3 go e

# Sot B3 pegn L) Fw ) e | T Design Summary [x]
—
= CEEE
Launching Design Summary/Report Viewer... R

1) INFO:HDLCompiler: 1061 - Parsing VHDL file "C:/Xilinx/Projectl/Projectl/Modulel.vhd” into library work
J)INFO:Project¥gme - Parsing design hierarchy completed successfully.
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A el LY IS amies a3l bl 5l e S Ol | “New Project” s 5

& New Project Wizard

Create New Project

Specify project location and type.
Enter a name, locations, and comment for the project
Name: Full_Adder

Location: C:\Xilinx\Project1)\ Ful_Adder

Working Directory: | C:\Xilinx\Project1\Full_Adder

Description:

ECE, University of Sistan and Baluchestan

Select the type of top-level source for the project
Top-level source type:

HDL v

o e coc
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New Project Wizard

Project Settings

Specify device and project properties,

Select the device and design flow for the project

Property Name Value
Evaluation Development Board None Specified
Product Cateqory All

Family Spartanb
Device XCBSLX4
Package TQG144

Speed -3

Top-Level Source Type
Synthesis Tool

HDL
XST (VHDL/Verilog)

Simulator 1Sim (VHDL/Verilog)
Preferred Lanquaqe VHDL

Property Specification in Project File  Store all values
Manual Compile Order |

VHDL Source Analysis Standard VHDL-93

Enable Message Filtering O

More Info

Cancel
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1 Schematic
2 HDL.: Hardware Description Language
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& |SE Project Navigator (P.20131013) - EMNISE Projec

File Edit View Project Source Process
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\ Design «+08& X
(7)) Ve @ {8} 1mplementation O [l Simulation
5| | Hierarchy a

G| € Full Adder
— | = E3 xcBsix9-2tqgl44

fakad Empty View

— The view currently contains no files.
You can add files to the project

- using the toolbar at left, commands
from the Project menu, and by
using the Design, Files, and
Libraries panels.

Use:

* New Source: To create a
new source file.

o Add Source: To add an ™

o555 Slp L source G ol VY S

1 Test Bench
2 Implementation Constraints File
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& New Source Wizard X

- Select Source Type
Select source type, file name and its location.

</ IP (CORE Generator & Architecture Wizard)
Schematic

User Document
Verilog Module

|| Verilog Test Fixture

— VHDL Meodule R
VHDL Library = )
VHDL Package | Full_adder |
g VHDL Test Bench )
A Location:

A2 Embedded Processor =
E:\ISE Projects\Four_Bit_Adder

@gdd to project

More Info Next = Cancel
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& New Source Wizard X
“Define Module
Specify ports for module.
Entity name | Ful_Adder
Architecture name  Behavioral
Port Name Direction Bus MSB LSB 2
in ~ [
in v []
in ~| ]
in v [
in ~1 [
in v [
in ~| ]
in ~I[]
in ~| ]
in | [] v
More Info < Back Mext » Cancel
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& ISE Project Navigator (P.20131013) - EAISE Projects\Four_Bit_ Adder\Four_Bit_Adderise - [Full_Addervhd] o
2 File Edit View Project Source Process Tools Window Layout Help -
DAHP L snobx|wal s prrRI[A 2o selrfl @
Dasgn L= m ]
[ | vew: @ {8 impiementation O [l Seiation [
&3] | Hierareny
@ @] Four_Bit_Adder N
2 (1 xcshg-2ggidd
’ B [Full_Adder - Behavioral (Full_Ad|
s
a 4
B e
- r
“
O
Q
< >
P B2 o Processes Running
7L | Mo single design module is selected.
9 [@ P  Design nilties
T
32 entity Full_Adder is
33 end Full hdder:
34 E
< >
B Ful_Addacvhd [ 1k Dasign Summary
—
Console “0 8
Started : "Launching ISE Text Editor to edit Full Rdder.vhd".

Launching Design Summary/Report Viewer...

<

[ consce @ Erom I\ wamngs B4 Findin Fes Rasuts

Ln1Cel1 VHDL

Js3lb oo 5 4 g0 AT K2

& New Source Wizard

€-Select Source Type

Select source type, file name and its location.

[ BMM File

B2 Implementation Constraints File

MEM File

Schematic

User Document
Verilog Module
Verilog Test Fixture
VHDL Module

VHDL Library

VHDL Package
VHDL Test Bench
Embedded Processor

€* ChipScope Definition and Connection File

%/ IP (CORE Generator & Architecture Wizard)

Fie name:

[ Full_adder_icf

Location:

E:\ISE Projects\Full_Adder

@
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& Design Utilities

v | @ 3%  User Constraints
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# fQ  Implement Design

)  Generate Programming File
¥ Configure Target Device
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» (] No Processes Running

?{: Processes: FA1 - full_adder_vhdl_code - gate_|
N2 %  Design Utilities

— )  Create Schematic Symbol

ﬂt. @ View HDL Instantiation Temp...
— )  Check Syntax

Top Module . source (sl A1 5 g0, N4 K
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g ‘-' £| Add Source... ™M
‘ ] [§z] Add Copy of Source...
[ i
[ Fou Res
4=| Remove
Manual Compile Order
15 Setas Top Module h
= SmartGuide... .
B ner o P Implement Top Module
71 | Processes: Four_Bit File/Path Display 4
2| @ g Design!  Expand Al =
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P | F) No Processes Running

Processes: full_adder_vhdl_code - gate_level
= Design Summary/Reports
+ Design Utilities
User Constraints

Synthesize - XST

View RTL Schematic

View Technology Schematic
2  Check Syntax

T2  Generate Post-Synthesis Sim...
# P2  Implement Design
€2  Generate Programming File

# %  Configure Target Device
€%  Analyze Design Using ChipScope
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& Set RTL/Tech Viewer Startup Mode e

Select how the RTL/Tech Viewer behaves when it is initially invoked
Startup mode

mmmel () Start with the Explorer Wizard

In this mode, the Explorer Wizard is the initial screen, and allows
you to select the elements that you want to see on the initial
schematic

—* ® Start with a schematic of the top-level block

In this mode, the Explorer Wizard is bypassed and an initial
schematic is created with only the top-level block displayed. You can
then use the logic expansion capabilities of the Viewer to start
expanding from the top-level block

You can also change the startup mode by selecting Edit->Preferences under
the RTL/Tech Viewer page

Show this dialog on startup

Soled Gl g bl XY JSs

a1y el lod Lo 5 ans el ot Sl Sles led ami o Lt oS LSl 1 0 4w S oS 0 3
b 3l e i ol San 135 ol eale ol 0 g plad 4 (51 5 VY S e JolS Sy
SUS L 53 i O s Al oo ot ol 51 52 038 5L 5 0dd 5333 (6l i S5k G s

full_adder_vhdl_code:1

Mxor_S1

Mxor_A_B_XOR_1_o1

Mxor_A_B_XOR_1_o1

full_adder_vhdl_code

Full_Addesvhd P Design Summary (Syntheszed) o) full_sdder_vhdl_code (RTL2) [x]

IRUCIISANIC GG - PSR NCIE NCRCHPER |



2 b el 5K S 48 S Ol B s e enls OLES ek w0 (6,503 ominn () 4 S bl & g 55 il
Solas 53 ls 5l aS 1y St 51 plaS e O cpl sl (ol ey b S plaS) Wi osls iled Solacs
3 e S Lol Sl a1y Lol “Add ->7 1S 05 25 L 5 s S Ol (T8 JSK8) Cor s 3l 5 0313 OLES
S ey Gl L gl p Sl U ues S “Create Schematic” sau S 5y » s S aslsl |y ol =) plod 4|
S 4 B eSS L gs ccnl ol ols (lolad Sl s 4085 i 8 ) KlS e 0 Rl 58 pl o
SIS L 53 n g 03 80 WLl Sled 0 Y ISCE (Gaomin 53 45 Sz G0 » S e w255 0l OLES 558

A Al wilol Soled 4 8355 Sy 4 s 55 OF S

Create Technology Schematic

1) Select items you want on the schematic from the "Available Elements” list and move them to the "Selected Elements” list
- Use the Filter control to filter the "Available Elements” list by name
2) Press the "Create Schematic” button to generate a schematic view using the items in the "Selected Elements” list

Available Elements Selected Elements
= & full_adder_vhdl_code T A_BUF
=17 Primitives O Cout
O A_IBUF <- Ramave =+ Cout_OBUF
|# » B_IBUF
= Cin IBUF <<~ Remove Al
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HDLCompiler:806 - "E:/ISE Prodjects/Full Adder/Full Adder tb.vhd™ Line 80: Syntax error near "<"
HDLCompiler:806 - "E:/ISE Prodects/Full Adder/Full Adder tb.vhd"™ Line 93: Syntax error near "<",.
ProjectMgmt - 4 error(s) found while parsing design hierarchy.

<
[E] consce @ Erors A\ Wamings [@§ Findin Fies Results
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---First One---
constant <clock> period : time := 10 ns;
---Second One---
<clock> process :process
begin
<clock> <= '0';
wait for <clock> period/2;
<clock> <= '1"';

wait for <clock>_period/2;
end process;

---Third One---

wait for <clock> period*10;
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